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	أفضل الممارسات – اتفاقيات الفيديو  Adobe Animate CC
	تصدير الفيديو Export Video  ببرنامج Animate CC
	تطوير مهاراتك في الوسائط المتعددة والفيديو في لبرنامج Adobe Animate CC .              
	 في نهاية هذه الكتاب ستكون قادر على :
	 التعرف على ملفات SVG .
	 تصدير ملفات SVG .
	 التعامل مع رموز متعددة Handling multiple symbols .
	 تصدير الأعمال الفنية بتنسيق SVG format .
	 استيراد الأصوات "Importing sound".
	 التعرف على الملفات الصوتية المدعومة في البرنامج .
	 تحرير الصوت في البرنامج "Edit a sound in Animate".
	 تقسيم الصوت على الجدول الزمني .
	 تحرير الصوت في Soundbooth  .
	 إنشاء ملفات الفيديو في برنامج Animate .
	 تنسيق الفيديو في البرنامج "Video format".
	 التعرف على أفضل الممارسات واتفاقيات الفيديو في برنامج Animate .
	تمتع بتصميم أجمل وأروع رسوماتك المتحركة عبر وضع أصول في مخططات مختلفة. وتمتع بتعديل عمق الطبقة وتعديلها ، وتكبير المحتوى في مخططات محددة. بالإضافة إلى هذا، يمكنك تأمين العناصر إلى الكاميرا وجعل حركات الكاميرا وعمق الطبقة تفاعليًا في وقت التشغيل .
	وتمتع بمشاهدة الأيقونات والنص بتفاصيل دقيقة جدًا مع بكسلات أكثر معروضة على شاشتك . ويعمل Animate CC تلقائيًا على تحسين إعداداتك لتناسب شاشات HiDPI.
	ويمكنك استخدام V-Cam المدمجة للAnimate CC والتصغير والتكبير على رسومك المتحركة كما لو أنك تستخدم كاميرا فيديو. وكما تسمح لك V-Cam بإضافة الصبغات والمرشحات إلى عملك .
	وتستطيع استخدم تصدير الدقة المخصص لضمان عرض فيديوهاتك بشكل رائع على أحدث أجهزة التلفزيون والشاشات فائقة الجودة. 
	وهذا كله في برنامج Adobe Animate C . 
	- ما هو SVG  ؟
	هي الرسوميات المتجهية متغيرة الحجم .وتوفر ملفات SVG رسومات مستقلة، وHiDPI graphics على الويب، وفي الطباعة، وعلى أجهزة الجوال في شكل مضغوط. 
	يمُكنك تعامل مع نمط وصور SVG مع CSS ، و البرمجة النصية والرسوم المتحركة فصور SVG تجعلك جزءا لا يتجزأ من منصة على شبكة الإنترنت.
	بعض أشكال الصور الشائعة للويب، مثل GIF, JPEG, PNG ، قد تكون كبيرة الحجم وعادة ما تكون ذات دقة منخفضة. 
	يوفر تنسيق SVG قيمة أكبر بكثير من خلال السماح لك لوصف الصور من حيث الأشكال المتجهة والنصوص وتأثيرات الفلتر. 
	وملفات SVG هي ملفات مدمجة وتوفر رسومات عالية الجودة على شبكة الإنترنت وعلى الأجهزة المحمولة التي لديها قيود للموارد، وكذلك. يمكنك تكبير عرض صورة SVG على الشاشة دون المساس بالجودة أو التفاصيل أو الوضوح. بالإضافة إلى ذلك، يوفر SVG دعماً متفوقاً للنص والألوان، مما يضمن لك رؤية الصور كما تظهر في المرحلة. 
	وتنسيق SVG يستند إلى XML بالكامل ويقدم العديد من المزايا للمطورين والمستخدمين الآخرين على حد سواء.
	- تصدير صور SVG في Animate CC :
	Animate CC يسمح لك للتصدير إلى تنسيق SVG، الإصدار 1.1.
	ويمكنك إنشاء عمل فني غني بصرياً باستخدام أدوات تصميم قوية متوفرة ضمن Adobe Animate ، ومن ثم التصدير إلى SVG.
	في Animate CC ، يمكنك تصدير إطارات وإطارات أساسية محددة للرسوم المتحركة. ولأن العمل الفني الذي تم تصديره هو فيكتور، فإن دقة الصورة عالية حتى على القياس إلى أحجام مختلفة.
	تستبدل ميزة تصدير SVG تصدير FXG السابق (انخفض من Animate CC (يونيو 2013)).
	سوف تجد أن أداء ميزة التصدير SVG وجودة الانتاج هو أعلى بكثير. أيضاً ، بالمقارنة مع FXG ، 
	ففقدان المحتوى هو الحد الأدنى في SVG.
	- العمل الفني Artwork مع تصفية الآثار  : Filter effects 
	مع SVG ، قد لا تظهر تأثيرات الفلتر تماماً كما هو الحال في Adobe Animate، حيث لا يوجد تعيين واحد إلى واحد بين الفلاتر المتوفرة في Adobe Animate و SVG. ومع ذلك، Animate Pro زاد من مجموعات المرشحات البدائية المختلفة المتاحة داخل SVG لمحاكاة تأثير مماثل.
	- التعامل مع رموز متعددة Handling multiple symbols :
	يعالج تصدير SVG رموز متعددة بسلاسة، دون أي فقدان للمحتوى . فالإخراج output يشبه إلى حد بعيد العمل الفني على منطقة العمل داخل البرنامج .
	- تصدير الأعمال الفنية بتنسيق SVG format :
	1. في Animate CC ، قم برسم أو بتصميم أي كائن في منطقة العمل .
	2. Select File > Export >Legacy  Export Image. 
	أو من ملف File > أختر إعدادات النشر Publish Settings (حدد خيارات الصورة في قسم التنسيقات الأخرى).
	3. أدخل Enter أو تصفح browse إلى الموقع حيث تريد حفظ SVG file. تأكد من تحديد كنوع حفظ باسم  SVG file. 
	4. انقر فوق موافق Ok.
	5. في مربع الحوار تصدير SVG ، اختر تضمين أو ربط ملف SVG الخاص بك.
	6. Include Hidden Layers تضمين الطبقات المخفية تصدر جميع الطبقات المخفية في وثيقة Adobe Animate CC. يؤدي إلغاء تحديد " Export Hidden Layers prevents all layers" كل الطبقات 
	(بما في ذلك الطبقات المتداخلة داخل movie clip) إلى إخفاءها في تصدير SVG. 
	وهذا يتيح لك بسهولة اختبار إصدارات مختلفة من مستندات البرنامج عن طريق جعل طبقات غير مرئية " making layers invisible ".
	7. تضمين Embed  : تضمين صورة نقطية في ملف SVG. استخدم هذا الخيار إذا كنت تريد تضمين الصور النقطية مباشرة داخل ملف SVG.
	8. رابط Link : يوفر وصلة إلى مسار ملفات الصور النقطية. استخدم هذا الخيار عندما لا ترغب في تضمينه، وإذا قمت بتحديد خيار نسخ الصور إلى مجلد Copy Images to Folder ، سيتم حفظ الصور النقطية في مجلد الصور التي تم إنشاؤها في الموقع حيث يتم تصدير ملف SVG. 
	وعند عدم تحديد نسخ الصور إلى " Images to Folder option" ، سيتم الإشارة إلى الصور النقطية في ملف SVG من موقع المصدر الأصلي. في موقع مصدر الصورة النقطية " case the bitmap source" غير متوفر ثم سيتم تضمينها داخل ملف SVG.
	9. نسخ الصور إلى مجلد / الصور Copy Images to /Images folder : يسمح لك بنسخ الصورة النقطية إلى مجلد الصور. ويتم إنشاء مجلد / Images folder ، إذا لم يكن موجودا بالفعل، في موقع تصدير SVG.
	- تبادل ملفات SVG مع Adobe Illustrator Animate :
	برنامج Animate CC يتيح لك تبادل المحتوى مع Adobe Illustrator. 
	وهذا العمل هو بديل للميزة "export SVG" التي أسقطت مع (13.0) Animate CC. فيمكنك تصدير ملفات SVG من داخل Adobe Animate ، واستيرادها داخل Adobe Illustrator.
	وبرنامج Adobe Illustrator يسمح لك لإضافة تأثيرات ، مثل إسقاط الظل " drop shadow" إلى العمل الفني .
	لتعديل ملفات SVG داخل أدوب إلوستراتور واستخدام المحتوى الذي تم تعديله ضمن Adobe Animate ، 
	نفذ ما يلي:
	1) في Animate CC ، تصدير إلى " export to SVG".
	2) تحرير العمل الفني الخاص بك عن طريق فتح ملف SVG باستخدام Adobe Illustrator.
	3) حفظ ملف SVG كملف بإمتداد   ai، واستيراد داخل Animate. 
	تقدم Adobe Animate عدة طرق لاستخدام الصوت . وجعل الأصوات التي تلعب بشكل مستمر، مستقلة عن الجدول الزمني، أو استخدام الجدول الزمني لمزامنة الرسوم المتحركة إلى مسار الصوت. 
	وإضافة الأصوات إلى أزرار لجعلها أكثر تفاعلية، وجعل الأصوات تتلاشى داخل وخارج مسار الصوت أكثر مصقول.
	وهناك نوعان من الأصوات في الحركة :
	أصوات الحدث وأصوات مجرى الصوت " event sounds and stream sounds".
	يجب أن يتم تنزيل صوت الحدث بالكامل قبل بدء التشغيل، ويستمر في التشغيل حتى يتوقف بشكل صريح. تبدأ الأصوات " stream sounds" اللعب في أقرب وقت البيانات بما فيه الكفاية الفريمات القليلة الأولى تم تحميلها. تتم مزامنة الأصوات " stream sounds" إلى الجدول الزمني للعب على موقع على شبكة الانترنت.
	إذا كنت تنشئ محتوى متحرك لأجهزة الجوال، فستتيح لك ميزة Adobe Animate أيضا تضمين أصوات الجهاز في ملف SWF الذي تم نشره. 
	ويتم ترميز أصوات الجهاز في تنسيق الصوت المدعومة أصلاً للجهاز، مثل MIDI ، MFi ، أو SMAF.
	يمكنك استخدام المكتبات المشتركة لربط الصوت بمستندات متعددة. يمكنك أيضا استخدام حدث event
	لتشغيل حدث بناء على إكمال صوت في منصة  ActionScript 2.0 و ActionScript 3.0 . 
	ويمكنك تحميل الأصوات والتحكم في تشغيل الصوت باستخدام السلوكيات الكتابة مسبقاً أو مكونات الوسائط. 
	هذا الأخير أيضا توفير وحدة تحكم لوقف  stop، وقفة  pause، أو التراجع  rewind، إلخ .
	 يمكنك أيضا استخدام 2.0ActionScript  أو 3.0 لتحميل الأصوات ديناميكياً . 
	*ملاحظة : لا يتم دعم ActionScript 2.0 و ActionScript 1.0 باستخدام Animate CC.
	- استيراد الأصوات " Importing sounds" :
	يمكنك وضع ملفات الصوت في حركة عن طريق استيرادها إلى المكتبة أو استيرادها مباشرة إلى منطقة العمل .
	يؤدي الخيار ملف  File> استيراد  Import> استيراد إلى مكتبة Import to Stage إلى وضع الصوت فقط في المكتبة ، وليس على المخطط الزمني.
	عند استيراد ملف صوتي باستخدام ملف File > استيراد Import > خيار استيراد Import To Stage إلى مرحلة القائمة أو عن طريق سحب وإسقاط ملف الصوت مباشرة إلى الجدول الزمني، سيتم وضع الصوت على الفريم النشط للطبقة النشطة. 
	وإذا قمت بسحب وإسقاط ملفات صوتية متعددة، سيتم استيراد ملف صوتي واحد فقط لأن إطار واحد يمكن أن يحتوي على صوت واحد فقط. 
	- لاستيراد الصوت ، استخدم إحدى الطرق التالية :
	• لاستيراد ملف صوتي إلى المكتبة، حدد ملف  select File> استيرادImport > استيراد إلى مكتبة Import To Library وحدد الملف الصوتي الذي تريد استيراده.
	• لاستيراد ملف صوتي إلى مرحلة ، حدد ملف  select File> استيراد  Import> استيراد إلى منطقة العمل Import To Stage وحدد الملف الصوتي الذي تريد استيراده.
	• سحب وإسقاط ملف الصوت مباشرة إلى المرحلة "Drag-and-drop the audio file directly to the stage". 
	*ملاحظة: يمكنك أيضاً سحب صوت من مكتبة مشتركة إلى المكتبة للمستند الحالي.
	/
	ويتم تخزين الأصوات في البرنامج "Animate stores sounds" في المكتبة جنباً إلى جنب مع الصور النقطية والرموز. تحتاج نسخة واحدة فقط من ملف الصوت لاستخدام هذا الصوت طرق متعددة في المستند الخاص بك.
	إذا كنت ترغب في مشاركة الأصوات بين وثائق Animate CC، يمكنك تضمين الأصوات في المكتبات المشتركة.
	يتضمن البرنامج مكتبة صوتية تحتوي على العديد من الأصوات المفيدة التي يمكن استخدامها أكثر من مره. لفتح مكتبة الأصوات ، 
	اختر ويندو Window > Common Libraries > Sounds. 
	لاستيراد صوت من مكتبة الأصوات إلى ملف Animate، اسحب الصوت من مكتبة إلى لوحة المكتبة Sounds library من ملف Animate الخاص بك. يمكنك أيضا سحب الأصوات من مكتبة تأثيرات صوتية إلى المكتبات المشتركة الأخرى.
	والأصوات يمكن تستخدام كميات كبيرة من مساحة القرص disk space وذاكرة الوصول العشوائي RAM. 
	ومع ذلك ، يتم ضغط البيانات الصوت ل MP3 وأصغر من WAV أو AIFF البيانات الصوتية.
	عموماً ، عند استخدام ملفات WAV or AIFF ، فمن الأفضل لاستخدام kHz  16-22 أحادية الأصوات 
	والان البرنامج يقوم بإستيراد إما bit  8- أو 16 الأصوات في معدلات عينة من 11، 22، أو 44. 
	يتم إعادة تمثيل الأصوات المسجلة بأشكال ليست مضاعفات kHz 11 (مثل 8 أو 32 أو 96 كيلو هرتز) عند استيرادها إلى البرنامج .
	والبرنامج يمكن أن يحول الأصوات لخفض معدلات العينة عند التصدير.
	إذا كنت ترغب في إضافة تأثيرات على الأصوات في Animate CC، فمن الأفضل لاستيراد الأصوات bit  16. إذا كان لديك رام محدودة، والحفاظ على مقاطع الصوت قصيرة أو العمل مع الأصوات 8 بت بدلا من الأصوات 16 بت.
	*ملاحظة: (Animate CC only في برنامج أنيميت فقط) 
	عند استيراد import أو تشغيل الأصوات play في Animate ، لا حاجة إلى تثبيت QuickTime or iTunes .
	- تنسيقات الملفات الصوتية المدعومة " Supported sound file formats" :
	&& يمكنك استيراد تنسيقات الملفات الصوتية التالية إلى البرنامج :
	• أدوبي الصوت (.asnd). هذا هو تنسيق الصوت الأصلي من " Adobe® Soundbooth". 
	Wave  (.wav)
	 AIFF (.aif، .aifc)
	 MP3
	&& يمكنك استيراد تنسيقات الملفات الصوتية الإضافية التالية :
	 Sound Designer® II (.sd2)
	 Sun AU (.au, .snd)
	 FLAC (.flac)
	 Ogg Vorbis (.ogg, .oga)
	  (The ASND format) تنسيق ملف صوتي غير متلف ويمكن تنسيق الصوت مع التأثيرات والمسارات المختلفة . 
	 منصة WebGL and HTML5 Canvas  يدعموا تنسيقات (MP3 and WAV) فقط.
	- تحرير الصوت في البرنامج " Edit a sound in Animate " :
	يمكنك تعريف نقطة البداية للصوت أو التحكم في مستوى الصوت أثناء تشغيله. يمكنك أيضاً تغيير النقطة التي يبدأ الصوت ويوقفه . وهذا مفيد لجعل ملفات الصوت أصغر من خلال إزالة الأقسام غير المستخدمة :
	1. أضف صوتاً إلى إطار، أو حدد إطاراً يحتوي بالفعل على صوت.
	2. حدد نافذة Window> خصائص   Properties
	3. انقر فوق الزر تحرير على الجانب الأيمن من لوحة الخصائص Property .
	4. قم بأي مما يلي :
	- لتغيير نقطة البداية والنهاية للصوت، اسحب عناصر التحكم في الوقت والوقت في تحرير.
	- لتغيير الصوت "To change the sound envelope" اسحب مقابض المغلف لتغيير المستويات عند نقاط مختلفة في خطوط sound.Envelope تظهر مستوى الصوت أثناء تشغيله. 
	لإنشاء مقابض مغلفات إضافية (تصل إلى ثمانية إجمالي)، انقر فوق envelope lines . لإزالة مقبض envelope handle ، اسحبه من النافذة.
	• لعرض أكثر أو أقل من الصوت في النافذة ، انقر فوق  Zoom In أو Out.
	• لتبديل وحدات الوقت "time units" بين الثواني والإطارات ، انقر فوق أزرار ثواني  Secondsوإطارات Frames buttons.
	5. لسماع الصوت المحرر edited sound ، انقر على زر التشغيل Play button.
	- تقسيم الصوت على الجدول الزمني "Split a sound on timeline" :
	يمكنك تقسيم الصوت تيار جزءاً لا يتجزأ من الجدول الزمني باستخدام قائمة Split Audio context menu . Split Audio تمكنك من وقفة الصوت عند الضرورة ومن ثم استئناف تشغيل الصوت من النقطة التي تم إيقافها في إطار لاحق على الجدول الزمني.
	- لتقسيم مقطع صوتي على المخطط الزمني :
	1) أختر ملف File > Import > Import to library استيراد إلى المكتبة  .
	2) حدد مقطع الصوت audio clip واستيراده إلى المكتبة import it to library.
	3) إنشاء طبقة جديدة على الجدول الزمني الخاص بك وإضافة مقطع للطبقة.
	خصائص  Properties > الصوت  Sound ، حدد نوع المزامنة the Sync .
	5) انقر نقراً مزدوجاً فوق الإطار الذي تريد تقسيم الصوت وانقر فوق تقسيم الصوت "Split Audio".
	- تحرير صوت في Soundbooth :
	إذا كان لديك Adobe Soundbooth ، يمكنك استخدام Adobe Soundbooth لتحرير الأصوات التي قمت باستيرادها إلى ملف Animate CC الخاص بك. بعد إجراء تغييرات في Adobe Soundbooth، عند حفظ الملف والكتابة فوق الأصلي، تنعكس التغييرات تلقائياً في ملف برنامج Animate.
	إذا غيرت اسم الملف أو شكل الصوت بعد تحريره ، فستحتاج إلى إعادة استيراده إلى Animate.
	*ملاحظة: يتوفر Soundbooth فقط على أجهزة الكمبيوتر ويندوز " Windows computers"و ماسينتوشيس Intel® " Intel®-based Macintoshes".
	لتعديل صوت تم استيراده في  Soundbooth: 
	1- انقر نقراً مزدوجاً (Windows) أو Ctrl-click (Macintosh) على الصوت في لوحة المكتبة Library panel .
	2- قم باختيار الصوت بالزر الأيمن ثم تحريره بواسطة برنامج Soundbooth . يتم فتح الملف في  Soundbooth.
	3- تحرير الملف في Soundbooth.
	4- عند الانتهاء ، احفظ الملف. لحفظ التغييرات بتنسيق لتعديله فيما بعد ، اختر تنسيق ASND format.
	إذا قمت بحفظ الملف بتنسيق مختلف عن النسخة الأصلية، فستحتاج إلى إعادة استيراد ملف الصوت إلى Animate.
	5- ارجع إلى البرنامج أنيميت لرؤية النسخة المعدلة من ملف الصوت في لوحة المكتبة Library panel.
	*ملاحظة: لا يمكنك تحرير الأصوات من مكتبة الأصوات (Window > Common Libraries > Sounds) مع الأمر تحرير في Soundbooth. 
	لتعديل هذه الأصوات في Soundbooth، 
	افتح Soundbooth وحدد الصوت من لوحة الظاهرة . ثم قم بتحرير الصوت ثم قم باستيراده إلى Animate مره أخرى . 
	/
	Adobe Animate يُمكنك من أن تتضمن لقطات الفيديو الرقمية في العروض على شبكة الإنترنت. 
	صيغ الفيديو FLV و F4V تقدم الفوائد التكنولوجية والإبداعية التي تُمكنك من دمج الفيديو جنباً إلى جنب مع البيانات والرسومات والصوت، والتحكم التفاعلي. 
	والفيديو FLV و F4V تُمكنك من وضع الفيديو بسهولة على صفحة ويب في شكل يُمكن لأي شخص تقريباً عرض هذه الفيديوهات.والبرنامج يساعدك بكيفية نشر الفيديو الخاص بك ويحدد كيفية إنشاء محتوى الفيديو الخاص بك كذلك ، وكيفية دمجها مع حركة.
	يمكنك البرنامج بتضمين الفيديو بالطرق التالية:- بث الفيديو باستخدام  "Adobe Media Server" :يمكنك استضافة محتوى الفيديو على Adobe® Media Server ، الخادم server هو الحل الأمثل لتقديم وسائل الإعلام في الوقت الحقيقي. باستخدام Adobe® Media Server وبروتوكول التراسل Protocol (RTMP)
	وهذا البروتوكول مصمم لتطبيقات الخادم في الوقت الفعلي مثل بث الفيديو والمحتوى الصوتي. 
	يُمكنك استضافة برنامج Adobe® Media Server، أو استخدام خدمة بث فيديو Flash® Video® Streaming Service (FVSS). 
	وقد أبرمت شركة أدوب شراكة مع العديد من موفري شبكة تسليم المحتوى network (CDN) لتقديم خدمات مستضافة لتقديم مقاطع فيديو FLV أو F4V عند الطلب عبر شبكات عالية الأداء وموثوق بها. بنيت مع Adobe® Media Server ومتكاملة ومباشرة في تسليم وتتبع وكذلك البنية التحتية التقارير تابعة لشبكة CDN، FVSS يوفر الطريقة الأكثر فعالية لتقديم ملفات FLV أو F4V إلى أكبر جمهور ممكن والحفاظ على تدفق الخاص بك أجهزة الخادم والشبكة.
	- تحميل الفيديو تدريجياً من خادم الويب " download video from a web server":
	إذا لم يكن لديك حق الوصول إلى أدوب Adobe Media Server  أو FVSS ، أو أن احتياجات الفيديو الخاصة بك هي لموقع ويب منخفض الحجم مع كميات محدودة فقط من محتوى الفيديو، يُمكنك التفكير في التحميل التدريجي.
	والتحميل التدريجي لمقطع فيديو من ملقم ويب لا يوفر الأداء في الوقت الحقيقي ؛ ومع ذلك، يمكنك استخدام مقاطع فيديو كبيرة نسبياً، والحفاظ على حجم ملفات SWF المنشورة إلى الحد الأدنى.
	للتحكم في تشغيل الفيديو وتوفير عناصر تحكم بديهية للمستخدمين للتفاعل مع الفيديو، استخدم مكون component or ActionScript.
	- تضمين فيديو في المستند Animate :
	يمكنك تضمين ملف فيديو صغير قصير المدة مباشرة في المستند Animate، ونشره كجزء من ملف SWF. ويؤدي تضمين محتوى الفيديو مباشرة إلى ملف SWF إلى زيادة كبيرة في حجم الملف المنشور، وهو مناسب فقط لملفات الفيديو الصغيرة (عادة أقل من 10 ثوان في الطول). 
	وبالإضافة إلى ذلك، يمكن أن يصبح مزامنة الصوت إلى الفيديو (المعروف أيضاً باسم audio/video sync) صعب عند المزامنة بشكل خاطئ فعند تحرير أو تعديل مقاطع فيديو بسبب عيب ما في ملف SWF لا يمكنك تحديث الفيديو بدون إعادة نشر ملف SWF مره أخرى.
	- التحكم في تشغيل الفيديو " Control video playback" :
	يُمكنك التحكم في تشغيل الفيديو في البرنامج باستخدام مكون " FLVPlayback component" عن طريق كتابة ActionScript مخصص لتشغيل فيديو خارجي، أو عن طريق كتابة ActionScript مخصص للتحكم في تشغيل الفيديو في المخطط الزمني للفيديو المضمن.
	 FLVPlayback component يتيح لك بسرعة إضافة عنصر تحكم تشغيل للفيديو بكامل المواصفات إلى المستند البرنامج ويوفر الدعم لكل من التحميل التدريجي وتدفق الملفات FLV أو F4V. 
	FLVPlayback يتيح لك بسهولة إنشاء ضوابط الفيديو بديهية للمستخدمين للتحكم في تشغيل الفيديو وتطبيق تصميم مسبقة الصنع موجودة في البرنامج ، أو تطبيق التصميمات المخصصة الخاصة بك إلى واجهة الفيديو.
	- قم بإدراج FLVPlayback component من قائمة component :
	/
	 فتح ملف Open Source Media Framework (OSMF) في البرنامج :
	OSMF تمكن المطورين بسهولة اختيار والجمع بين المكونات للتوصيل فيما بينها وتكون عالية الجودة، وكامل المواصفات لتشغيل الفيديوهات .
	 التحكم في الفيديو الخارجي باستخدام ActionScript :
	تشغيل ملفات FLV أو F4Vفي وثيقة البرنامج في وقت التشغيل باستخدام كائنات NetConnection and NetStream ActionScript objects .
	 التحكم في الفيديو المضمنة في المخطط الزمني :
	للتحكم في تشغيل ملفات الفيديو المضمنة control playback ، يجب كتابة ActionScript للتحكم في المخطط الزمني الذي يحتوي على الفيديو.
	- تنسيقات الفيديو في البرنامج " Video formats " :
	لاستيراد الفيديو إلى البرنامج يجب عليك استخدام الفيديو المشفر FLV أو بتنسيق H.264. ويقوم المعالج باستيراد الفيديو عن طريق (ملف  File> استيراد  Import> استيراد الفيديو Import Video) 
	بالتحقق من ملفات الفيديو التي تحددها للاستيراد، وينبهك إذا كان الفيديو لا يمكن تشغيله في البرنامج بسبب امتداده . ففي هذه الحالة لا يكون الفيديو بتنسيق FLV أو F4V، يمكنك استخدام برنامج Adobe®Media® لتحويل امتداد الفيديو بالتنسيق المناسب. كما في الصورة التالية :
	/
	/
	- تحميل الفيديو تدريجياً باستخدام خادم الويب " web server" :
	يتيح لك التحميل التدريجي استخدام FLVPlayback component أو ActionScript الذي تكتبه لتحميل ملفات FLV أو F4V الخارجية في ملف SWF عند التشغيل.
	نظرا لأن ملف الفيديو يتم الاحتفاظ به خارج محتوى Animate، فمن السهل نسبياً تحديث محتوى الفيديو بدون إعادة نشر ملف SWF.
	- يوفر التحميل التدريجي المزايا التالية على تضمين الفيديو في المخطط الزمني :
	• أثناء التأليف، يمكنك نشر ملف SWF فقط لمعاينة أو اختبار جزء أو كل من المحتوى Animate CC الخاص بك. ويؤدي هذا إلى إجراء اختبارات أسرع في أوقات المعاينة وتحويل أسرع للتجارب المتكررة.
	• أثناء التشغيل، يبدأ تشغيل الفيديو بمجرد أن يتم تحميل الجزء الأول من الفيديو ويتم تخزينه مؤقتا في محرك الأقراص المحلي.
	• في وقت التشغيل، يتم تحميل ملفات الفيديو بواسطة Flash Player من محرك أقراص الكمبيوتر إلى ملف SWF، مع عدم وجود قيود على حجم ملف الفيديو أو مدته. لا توجد مشكلات تزامن الصوت أو قيود الذاكرة موجودة.
	• معدل إطار ملف الفيديو يمكن أن يكون مختلفاً عن معدل إطار ملف ، مما يسمح لمزيد من المرونة في التأليف Animate CC المحتوى.
	- بث الفيديو باستخدام Adobe Media Server :
	Adobe Media Server تيارات الوسائط في الوقت الحقيقي إلى Flash Player and AIR. 
	ويستخدم Adobe Media Server الكشف عن عرض النطاق الترددي لتقديم محتوى الفيديو أو الصوت استناداً إلى عرض النطاق الترددي المتاح للمستخدم.
	يوفر بث الفيديو باستخدام Adobe Media Server المزايا التالية على الفيديو الذي تم تضمينه وتنزيله تدريجياً:
	• يبدأ تشغيل الفيديو في وقت أقرب من استخدامه باستخدام طرق أخرى لدمج الفيديو.
	• يستهلك تشغيل الفيديو أقل من ذاكرة الحاسوب ومساحة القرص، لأن العملاء لا يحتاجون إلى تنزيل الملف بأكمله.
	• تستخدم موارد الشبكة بكفاءة أكبر، لأن أجزاء الفيديو التي يتم عرضها فقط يتم إرسالها إلى العميل.
	• تسليم الوسائط أكثر أمناً، لأنه لا يتم حفظ الوسائط إلى ذاكرة التخزين المؤقت للعميل عند تدفقها.
	• يوفر الفيديو أفضل عرض وتتبع بكل سهوله وسرعه .
	• تشغيل يتيح لك تقديم لقطات فيديو حية والعروض الصوتية، أو التقاط الفيديو من كاميرا ويب أو كاميرا الفيديو الرقمية.
	• Adobe Media Server يتيح تدفق متعدد الوسائط ومتعدد المستخدمين للدردشة المرئية، والرسائل المرئية، وتطبيقات المؤتمرات بالفيديو.
	• باستخدام البرمجة النصية من جانب الخادم للتحكم في الفيديو وتيارات الصوت ، يمكنك إنشاء قوائم اللعب من جانب الخادم، تيارات متزامنة، وخيارات التسليم أكثر ذكاء على أساس سرعة الاتصال العميل.
	لمعرفة المزيد حول Adobe Media Server، راجع www.adobe.com/go/flash_media_server.
	لمعرفة المزيد حول خدمة بث الفيديو بالفلاش، راجع www.adobe.com/go/learn_fvss_en.
	- تضمين ملف فيديو ضمن ملف Animate :
	عند تضمين ملف فيديو ، تتم إضافة كافة بيانات ملف الفيديو إلى ملف Animate. يؤدي هذا إلى ملفSWF  أكبر حيث يتم وضع الفيديو في المخطط الزمني ويُمكنك مشاهدة إطارات الفيديو الفردية الممثلة في إطارات البرنامج . ولأن كل إطار فيديو يتم تمثيله بواسطة إطار في المخطط الزمني، يجب ضبط معدل إطار مقطع الفيديو وملف SWF على المعدل نفسه. إذا كنت تستخدم معدلات إطارات مختلفة لملف SWF ومقطع الفيديو المضمن، فإنه سيكون تشغيل الفيديو غير متناسق.
	*ملاحظة: لاستخدام معدلات الإطارات المتغيرة، قم بتدفق الفيديو باستخدام إما التحميل التدريجي أو Adobe Media Server. عند استيراد ملفات الفيديو باستخدام أي من هذه الأساليب، ملفات FLV أو F4V مكتفية ذاتياً ويتم تشغيلها بمعدل إطار منفصل عن ذلك من جميع معدلات الإطار الزمني الأخرى المضمنة في ملف SWF.
	يعمل الفيديو المضمن بشكل أفضل لمقاطع الفيديو الصغيرة، مع وقت تشغيل أقل من 10 ثوان. إذا كنت تستخدم مقاطع فيديو ذات أوقات تشغيل أطول، فجرب استخدام الفيديو الذي تم تنزيله تدريجياً أو بث الفيديو باستخدام Adobe Media Server.
	- تتضمن قيود الفيديو المضمنة ما يلي :
	• قد تواجه مشكلات إذا أصبحت ملفات SWF الناتجة كبيرة بشكل مفرط. يحتفظ Flash Player بعدد كبير من الملفات عند تنزيل ومحاولة تشغيل ملفات SWF كبيرة مع فيديو مضمن، مما قد يؤدي إلى فشل تشغيلFlash Player.
	• ملفات الفيديو الأطول (أكثر من 10 ثانية طويلة) غالباً ما يكون لها مشاكل التزامن بين مقاطع الفيديو والصوت وأجزاء مقطع فيديو. مع مرور الوقت، يبدأ المسار الصوتي في تشغيل التسلسل مع الفيديو، مما يؤدي إلى عدم الرغبة في مشاهدته .
	• لتشغيل فيديو مضمن في ملف SWF، يجب تنزيل ملف الفيديو بالكامل قبل بدء تشغيل الفيديو. إذا قمت بتضمين ملف فيديو كبير جداً، قد يستغرق الأمر وقتاً طويلاً لكي ينزل ملف SWF بكامله ويبدأ تشغيله.
	• بعد استيراد مقطع فيديو، لا يمكن تحريره. بدلاً من ذلك، يجب إعادة تحرير ملف الفيديو وإعادة استيراده مره أخرى .
	• عند نشر ملف SWF عبر الويب، يجب تحميل الفيديو بأكمله على جهاز الكمبيوتر الخاص بالمشاهد قبل بدء تشغيل الفيديو.
	• في وقت التشغيل، يجب أن يتناسب الفيديو بأكمله مع الذاكرة المحلية لجهاز التشغيل.
	• لا یمکن أن یتجاوز طول ملف الفيديو المستورد 16000 فريم.
	• يجب أن يكون معدل أطار الفيديو ومعدل الإطار الزمني للAnimate CC هو نفسه متساويان . 
	يمكنك معاينة إطارات فيديو مضمن عن طريق سحب رأس التشغيل على طول المخطط الزمني (scrubbing). لاحظ أن مسار صوت الفيديو لا يتم عرضه أثناء تحرير. لمعاينة الفيديو مع الصوت، استخدم الأمر Test Movie.
	- العمل مع نقاط تلميح الفيديو " cue points":
	ملاحظة: (Animate CC فقط) يتم إهمال ميزة نقاط التلميح للفيديو وسوف تكون غير متوفرة مع Animate CC
	استخدم نقاط مؤشره أو للتلميح الفيديو للسماح بتشغيل الأحداث في أوقات محددة من الفيديو. 
	هناك نوعان من نقاط تلميح أو التأشير التي يمكنك العمل معها في Flash :
	• " Encoded cue points "نقاط تلميح مشفرة  Encoded cue points: هي نقاط تلميح تنضاف عند ترميز الفيديو مع Adobe Media Encoder. 
	• " ActionScript cue points "نقاط تلميح باستخدام ActionScript. هي نقاط يتم إضافتها إلى الفيديو مع عارض الخصائص في Animate.
	ActionScript ينشئ نقطة تلميح يمكن الوصول إليها فقط بمشغل Flash Player. لمزيد من المعلومات حول نقاط تلميح في دليل المطور 3.0 ActionScript.
	عند تحديد FLVPlayback component في المرحلة، تظهر قائمة نقاط تلميح الفيديو في عارض الخصائص. يمكنك أيضا معاينة الفيديو بالكامل في منطقة العمل وإضافة " ActionScript cue points" باستخدام عارض الخصائص أثناء معاينة الفيديو، بما في ذلك مقاطع الفيديو التي يعرضها Adobe Media Server.
	للعمل مع نقاط cue points في عارض الخصائص:
	1- استيراد الفيديو بتحميله أو ضع عنصر FLVPlayback component على المسرح وتحديد الفيديو المصدر. يمكنك تحديد الفيديو المصدر في عارض الخصائص.
	2- في عارض الخصائص، انقر فوق نقاط Cue Points لتوسيع القسم، إذا لم يكن مفتوحاً بالفعل.
	3- انقر فوق الزر إضافة (+) لإضافة نقطة جديلة ActionScript، وزر الحذف (-) لحذف نقطة جديلة موجودة. يمكنك تحديد الوقت عن طريق سحب الماوس لليمين أو اليسار لزيادة أو تقليل قيمة الوقت أو عن طريق كتابة قيمه.
	4- لإضافة معلمة إلى نقطة تلميح ، حدد نقطة ActionScript cue point وانقر فوق الزر إضافة (+) أسفل قسم المعلمات.
	5- يمكنك إعادة تسمية ActionScript cue point وأي معلمات بالنقر في حقل الاسم وتحرير الاسم.
	يمكنك استيراد وتصدير قوائم نقطة cue point من داخل عارض الخصائص. يمكن استيراد نقاط cue point فقط لتجنب التضارب مع نقاط cue point التي تم تضمينها بالفعل داخل الفيديو أثناء الترميز.
	تسمح لك أزرار نقطة تلميح الاستيراد والتصدير في أعلى قسم cue point باستيراد أو تصدير قوائم cue point بتنسيق XML format. 
	وعند التصدير، تتضمن القائمة جميع cue point التنقل وحدث المضمنة في الفيديو، جنباً إلى جنب مع جميع نقاط تلميح ActionScript التي قمت بإضافتها. عند الاستيراد، يتم عرض مربع حوار يظهر عدد نقاط التلميح ActionScript المستوردة.
	حول اتفاقيات الفيديو " video conventions" :
	تتوفر العديد من الخيارات لتعديل الفيديو قبل استيراده إلى مستندFLA، أو تحميل ملف FLV إلى ملف SWF. 
	برنامج Animate و  Adobe Media Encoderلديها ضوابط أكبر لضغط الفيديو. 
	إن ضغط الفيديو بعناية أمر مهم لأنه يتحكم في جودة لقطات الفيديو وحجم الملف. 
	ملفات الفيديو، حتى عندما تكون مضغوطة، كبيرة بالمقارنة مع معظم الأصول الأخرى في ملف swf الخاص بك.
	*ملاحظة: تزود المستخدم بالتحكم في الوسائط في ملف swf. على سبيل المثال، إذا قمت بإضافة الصوت إلى مستند مع فيديو (أو حتى صوت خلفية حلقات)، فيستطيع المستخدم التحكم في الصوت.
	استخدام الفيديو في أحد التطبيقات application :
	قبل استيراد الفيديو إلى Animate، والنظر في نوعية الفيديو التي تحتاج إليها،
	انظر إلى ما هو تنسيق الفيديو لاستخدامها مع ملف FLA، وكيفية تنزيله. عند استيراد الفيديو إلى ملف FLA(يسمى الفيديو المضمن)، فإنه يزيد من حجم ملف SWF الذي تنشره. يبدأ تحميل هذا الفيديو تدريجياً إلى جهاز الكمبيوتر الخاص بالمستخدم سواء عرض الفيديو أم لا.
	يمكنك أيضاً تحميل أو بث الفيديو تدريجياً في وقت التشغيل من ملف FLV خارجي على الخادم الخاص بك. عندما يبدأ تحميل يعتمد على كيفية هيكلة التطبيق الخاص بك.
	*ملاحظة: يتم تنزيل الفيديو تدريجياً من الخادم مثل ملفات SWF، والتي لا يتم بثها في الواقع. يحتوي تحميل المحتوى ديناميكياً على مزايا متميزة على حفظ كل المحتوى الخاص بك في ملف SWF واحد. على سبيل المثال، سيكون لديك ملفات أصغر وتحميل أسرع، والمستخدم فقط بتحميل ما يريدون أن يرى أو استخدامها في التطبيق الخاص بك.
	يمكنك عرض الفيديو FLV الخارجي باستخدام عنصر أو كائن فيديو. عنصر يجعل تطوير التطبيقات مع FLV الفيديو سهلة، لأن الضوابط الفيديو هي مبنية مسبقاً، وتحتاج فقط لتحديد مسار ملف FLV لتشغيل المحتوى. للاحتفاظ بأصغر حجم ممكن من ملف SWF، اعرض الفيديو في كائن فيديو وأنشئ مواد العرض والرمز الخاص بك للتحكم في الفيديو. يمكنك أيضاً استخدام FLVPlayback component في أدوب Animate، الذي يحتوي على حجم ملف أصغر من مكونات الوسائط (MX Professional 2004 والإصدارات الأحدث).
	من المفيد منح المستخدمين بعض التحكم (مثل القدرة على إيقاف الفيديو مؤقتاً وإيقافه مؤقتاً وتشغيله واستئنافه والتحكم في حجمه) عبر الفيديو في ملف SWF.
	للحصول على أنواع معينة من المرونة على الفيديو، مثل التلاعب بالفيديو باستخدام الرسوم المتحركة أو مزامنة أجزاء متعددة منه مع المخطط الزمني، يمكنك تضمين الفيديو في ملف SWF بدلاً من تحميله باستخدام ActionScript أو أحد مكونات الوسائط.
	لمزيد من التحكم في الفيديو من فئة الفيديو يسمح ، وضع الفيديو داخل movie clip. يلعب الجدول الزمني للفيديو بشكل مستقل عن الجدول الزمني للبرنامج ، ويمكنك وضع المحتوى داخل movie clip للتحكم في الجداول الزمنية. لم يكن لديك لتمديد الجدول الزمني الرئيسي الخاص بك عن طريق العديد من الإطارات لاستيعاب للفيديو ، والتي يمكن أن تجعل العمل مع ملف FLA الصعب.
	استكشاف أخطاء الفيديو وإصلاحها  Troubleshooting video:
	يمكنك إنشاء تطبيق ثم تواجه مشاكل بعد تحميله إلى الخادم الخاص بك.
	• تحقق من صحة إصدار مشغل فلاش Flash Player .
	على سبيل المثال ، إذا قمت بتشفير الملفات باستخدام On2 codec ، تحتاج Flash Player 8 أو في وقت لاحق مثبتة للمتصفحات التي تستخدمها لعرض المحتوى التحريك الخاص بك.
	• تأكد من أن الخادم يدعم نوع " mime type" لملفات الفيديو التي تستخدمها ، FLV أو F4V. 
	• تحقق من إرشادات الأمان security guidelines .
	إذا قمت بتحميل ملفات FLV من ملقم آخر، تأكد من أن لديك الملفات المناسبة أو التعليمات البرمجية في مكان لتحميل من هذا الملقم الخارجي. 
	للحصول على معلومات حول ملفات السياسة، راجع ملفات نهج جانب الخادم للسماح بالوصول إلى البيانات في ActionScript 2.0. للحصول على معلومات حول التحميل والأمن، راجع فهم الأمان في ActionScript 2.0.
	• التحقق من المسارات المستهدفة إلى الفيديو الخاص بك صحيحة. إذا كنت تستخدم مسارات نسبية relative paths (مثل /video/water.flv)، 
	فجرب استخدام المسارات المطلقة absolute paths (مثل http://www.helpexamples.com/flash/video/water.flv). إذا كان التطبيق الخاص بك لا يعمل كمسار نسبي، ولكن يعمل بمثابة مسار مطلق، قم بتصحيح المسار النسبي.
	• تأكد من أن إصدار مشغل الفلاش Flash Player الذي حددته في إعدادات النشر Publish Settings يدعم نوع ملفات الفيديو التي تستخدمها، إما (H.264) FLV or F4V.
	/
	 يمكنك استيراد أو تصدير الفيديو مع الصوت بالبرنامج.
	 وكذلك يُمكن البرنامج استيراد FLV الفيديو وتصدير FLV أو QuickTime (MOV) .
	واستخدام الفيديو مع تطبيقات الاتصالات، مثل مؤتمرات الفيديو أو الملفات التي تحتوي على بيانات مشفرة مشاركة الشاشة تصديرها من خادم الوسائط أدوبي Adobe’s Media Server .
	عند تصدير مقاطع فيديو من البرنامج بتنسيق FLV مع الصوت المتدفق، تقوم إعدادات مربع حوار الصوت المتدفق بضغط الصوت.
	يتم ضغط الملفات في تنسيق FLV مع البرمجة إذا وجدت .
	تصدير نسخة من ملف FLV من المكتبة : 
	1- انقر نقراً مزدوجاً فوق مقطع الفيديو FLV في لوحة المكتبة.
	2- أختر خصائص من قائمة السياق context menu .
	3- في مربع الحوار خصائص الفيديو، انقر فوق تصدير Export .
	4- أدخل اسماً للملف الذي تم تصديره. حدد موقعاً لحفظه، ثم انقر على حفظ، وانقر على موافق.
	حول QuickTime :
	البرنامج يوفر طريقتين لتصدير وثائق برنامج أنيميت إلى QuickTime:
	QuickTime export :
	تصدير ملف QuickTime الذي يمكن توزيعه كفيديو أو على قرص DVD أو استخدامه في تطبيق تعديل الفيديو مثل Adobe® Premiere. 
	تصدير QuickTime مخصص للمستخدمين الذين يرغبون في توزيع المحتويات المتحركة، مثل الرسوم المتحركة، بتنسيق فيديو QuickTime.
	كن على علم بأن أداء الكمبيوتر المستخدم لتصدير فيديو QuickTime قد يؤثر على جودة الفيديو. إذا كان غير قادر على تصدير كل إطار، فإنه سيتم إسقاط الإطارات، مما أدى إلى ضعف جودة الفيديو.
	حاول استخدام جهاز كمبيوتر أسرع في الذاكرة أو تقليل الإطارات في الثانية .
	نشر QuickTime :
	يخلق تطبيق مع مسار البرنامج في نفس تنسيق QuickTime المثبتة على جهاز الكمبيوتر الخاص بك. هذا يتيح لك الجمع بين الميزات التفاعلية للبرنامج مع ميزات الوسائط المتعددة والفيديو في فيلم واحد QuickTime ، أي شخص مع QuickTime أو في وقت لاحق يمكن عرضه.
	إذا قمت باستيراد مقطع فيديو (بأي تنسيق) في مستند كملف مضمن، يمكنك نشر المستند كفيلم QuickTime. إذا قمت باستيراد مقطع فيديو بتنسيق QuickTime إلى مستند كملف مرتبط، يمكنك أيضاً نشر المستند كفيلم QuickTime.
	تصدير كافة الطبقات في المستند أنيمات كطريقة تنشيط مسار واحد، ما لم تحتوي الوثيقة على فيلم QuickTime مستورد. يبقى فيلم QuickTime المستورد بتنسيق QuickTime في التطبيق الذي تم تصديره.
	تصدير Export الفيديوا  :
	1- أختار ملف File > Export > Export Movie.
	2- إعدادات لتصدير settings for the QuickTime movie to export
	بشكل افتراضي، يقوم تصدير "QuickTime" بإنشاء ملف فيلم باستخدام الأبعاد نفسها كمصدر Animate document وتصدير Animate document في مجملها. يحتوي مربع الحوار تصدير الفيديو على الخيارات التالية:
	/
	A- الأبعاد :
	العرض والارتفاع بالبكسل " pixels" لإطارات QuickTime movie . يمكنك تحديد العرض فقط أو الارتفاع ؛ يتم تعيين البعد الآخر تلقائياً للحفاظ على نسبة العرض إلى الارتفاع للمستند الأصلي. لتعيين كل من العرض والارتفاع بشكل مستقل عن بعضها البعض، قم بإلغاء تحديد deselect Maintain Aspect Ratio.
	*ملاحظة: إذا كانت أبعاد الفيديو كبيرة بشكل خاص (على سبيل المثال، 740 × 480 بكسل)، فقد تحتاج إلى تغيير معدل إطار الفيلم لتجنب إسقاط الإطارات.
	*ملاحظة: خيار الأبعاد الذي قمت بتعيينه في مربع الحوار إعدادات تصدير QuickTime هو لعرض و ارتفاع ملف FLA تصديرها كفيديو. 
	تحدد الأبعاد التي قمت بتعيينها في مربع حوار إعدادات QuickTime حجم فيلم QuickTime الذي تم تصديره. إذا لم تقم بتغيير حجم في الحوار في وقت لاحق، فإنه لا يزال "الحالية" لذلك لا تحتاج إلى تغييره.
	-B تجاهل مرحلة اللون  Ignore stage color :  
	لإنشاء قناة alpha باستخدام لون المرحلة . يتم ترميز قناة alpha كمسار transparent ، مما يتيح لك تراكب فيلم QuickTime الذي تم تصديره أعلى محتوى آخر لتغيير لون الخلفية أو المشهد .
	لإنشاء فيديو QuickTime مع قناة alpha ، يجب تحديد فيديو نوع ضغط يدعم ترميز 32 بت مع قناة alpha. برامج الترميز التي تدعم هذه هي الرسوم المتحركة، PNG, Planar RGB, JPEG 2000, TIFF, or TGA. 
	ويجب أيضاً تحديد مليون من اللون + من الإعداد ضاغط / العمق " Color+ from the Compressor/Depth setting ". 
	لتعيين نوع الضغط وعمق الألوان ، انقر على الزر إعدادات في فئة الفيديو من مربع الحوار Movie Settings
	عند الوصول إلى الإطار الأخير : يتم تصدير وثيقة أنيمات بأكملها كملف movie file .
	C- تحويل الفيديوا باستخدام برنامج Adobe Media Encoder .
	D- بعد انقضاء الوقت " After time has elapsed" .
	-E مدة وثيقة أنيمات لتصديرها في ساعات: دقائق: ثواني: أقل من ثانية.
	F – مكان حفظ الفيديو واسمه ثم Click Export .
	أوفت أدوبي اليوم بوعدها عندما قررت إطلاق Animate CC رسميا للمصممين، المطورين وصانعي الرسوم المتحركة كبديل لتطبيق Flash Professional الذي جذب على مدى سنوات كبار المصممين لصنع صفحات الويب المتحركة، الألعاب، التطبيقات وغيرها.
	ووصفت الشركة هذا الإصدار الأول لبرنامج Animate CC بأنه واحد من أضخم إصدارات الشركة على الإطلاق حيث ستقدم من خلاله بتسليط الضوء على العديد من المميزات الجديدة مثل دعم المكتبات السحابية الإبداعية Creative Cloud، خدمة Adobe Stock أو سوق بيع وشراء الصور إلى جانب دعم موسع لكل من خدمة Typekit و SVG.
	إلى جانب إطلاق Animate، قامت أدوبي بتحديث برنامج صنع مواقع الويب بأقل الأكواد Muse CC مع إضافة دعم التصميم المرن الذي يسمح له الظهور بشكله الصحيح على الأجهزة مهما كان حجمها.
	/
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